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Introduction

Recommended user settings

Introduction

For optimization of mobile communication networks, drive tests with coverage
measurement systems are being performed. The coverage measurement platform
provided by Rohde & Schwarz is based on R&S® ROMES, which is the application
software to define and setup measurement devices, acquire and store the
measurement data and displaying measured data during the measurement period and
a later replay.

Additional drivers are used for attaching different measurement devices, such as the
Rohde & Schwarz Universal Radio Network Analyzers TSMQ or TSMW or test mobiles
from different manufacturers. Depending on the required measurement tasks, R&S®
ROMES can be configured freely to adapt to the user’s needs.

As long as the measurements are performed in an outdoor environment using a
vehicle traveling around, size and weight of the measurement system is not a problem.
As more and more measurements are performed in an indoor environment by walking
around, size, weight and mechanical handling is an issue of interest. ROMES® can be
used in a light weight configuration, which is small enough to be carried in a back pack.
For use of R&S® ROMES with R&S® TSMW in an indoor environment, the Backpack
System R&S® TSMW-Z3 has been designed. The system includes a mini PC with
R&S® ROMES which needs to be controlled remotely.

This application note describes, how to establish a Wireless Lan Access Point on the
R&S® ROMES PC and to setup a wireless LAN connection between an Apple iPad®
and the mini PC.

Section 2, “Preparations of Windows on the server” on page 4 describes how to
configure Windows 7 for best use with R&S® ROMES in a remote session and how to
set-up and configure the WiFi network on the R&S® ROMES machine.

Section 3, “Setup a remote connection”, on page 14 describes how to configure and
start the remote desktop sessions on both, an iPad client and a Windows 7 PC. A short
selection guide for the appropriate App on iPad is also given.

Section 4, “Tips for Remote Controlled Sessions”, on page 35 gives some further hints
on the configuration and use of the sessions.

Note: this application note takes only the settings of Windows 7 into account. Please
refer to the application note 1SP51, for settings on Windows XP.

Please note:

Throughout this manual, TSMW is generally used as an abbreviation for
the Universal Radio Network Analyzer R&S® TSMW.

R&S® ROMES4 Drive Test Software is referred to as ROMES throughout this
document.

Microsoft® Windows 7 is referred to as Windows throughout this document
Apple iPad® is referred to as iPad throughout this document.

R&S® is a registered trademark of Rohde & Schwarz GmbH & Co. KG.
Trade names are trademarks of the owners.
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Preparations of Windows on the server

Recommended user settings

2 Preparations of Windows on the server

This section describes the recommended windows settings for use with a remote
session and with a ROMES measurement.

Note: This document describes only settings on Windows 7. Windows XP is handled in
the application note 1SP51.

2.1 Recommended user settings

Measurements with ROMES need to be performed with administrator rights. Therefore
it is recommended to setup the user as an administrator user.

Remote login to Windows can only be granted for users whose login is protected by a
password. Therefore it is not possible to activate an auto login on machines, which
shall be remotely controlled.

To create a user with both properties perform as follows:

Start > control Panel > User Accounts and Family Safety - Add or remove user
accounts

Create a new account > enter account name, e.g. "ROMES", select "Administrator”
- Create Account

Click on the newly created account - Create a password - enter the password twice
and optionally a password hint.

2.2 Power options

By default, Windows shuts down the computer after e.g. 15 minutes without user
interaction such as a keyboard stroke or a mouse movement. Since measurements
with ROMES can run fully without any user interaction, Windows may shut down the
computer after 15 minutes. To prevent this, change the default power options, again in
the control panel:

Control Panel - Hardware and Sound - Power Options
Create a power plan - High performance (name it, e.g. ROMES)
"Turn off the display": keep 15 minutes

1SP15_0E Rohde & Schwarz Remote Control of ROMES on Windows 7 4



Preparations of Windows on the server

Visual effects

2.3 Visual effects

Windows has got a lot of smart and nice looking desktop effects. These, however, cost
a lot of performance of the desktop computer and graphic card. Especially, when the
PC is remotely controlled, these effects require a lot of network bandwidth and slow
down the real time display of each measurement system. It therefore is highly
recommended, to reduce visual effects of the desktop to a minimum. The following tips
have been taken directly from Microsoft web site (http://windows.microsoft.com/en-
US/windows7/Optimize-Windows-7-for-better-performance).

2.3.1 Turn off visual effects

If Windows is running slowly, you can speed it up by disabling some of its visual
effects. It comes down to appearance versus performance. Would you rather have
Windows run faster or look prettier? If your PC is fast enough, you don't have to make
this tradeoff, but if your computer is just barely powerful enough for Windows, it can be
useful to scale back on the visual bells and whistles.

You can choose which visual effects to turn off, one by one, or you can let Windows
choose for you. There are 20 visual effects you can control, such as the transparent
glass look, the way menus open or close, and whether shadows are displayed.

To adjust all visual effects for best performance:

1. Open Performance Information and Tools by clicking the Start button (3, and then
clicking Control Panel. In the search box, type Performance Information and Tools,
and then, in the list of results, click Performance Information and Tools.

2. Click Adjust visual effects. “¥ If you're prompted for an administrator password or
confirmation, type the password or provide confirmation.

3. Click the Visual Effects tab, click Adjust for best performance, and then click OK.
(For a less drastic option, select Let Windows choose what'’s best for my
computer.)

2.3.2 Save the setting to a theme

Open the control panel again (or click on “control panel home” on the upper left corner
anywhere in the control panel) and click on “Change the theme” in “Appearance and
Personalization”. The currently created theme is displayed as “Unsaved Theme” in the
section “My Themes”. Right-click this theme an select “Save theme”.

Enter a name of your choice in the next dialog.
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Preparations of Windows on the server

Enable Remote session

Change the visuals and sounds on your computer

Click a theme to change the desktop background, window color, sounds, and screen sayver all at once.,

My Tharmes (1)

eme For sharing Save theme  Get more themes ¢

Weirl ovis 7 Architecture Characters Landscapes Mature

You may switch between the various themes later on at any time.

2.4 Enable Remote session

To be able to open a Remote Session on the measurement PC, it is necessary to allow
remote sessions for at least one user.

Open the Control Panel - System and Security - Allow remote access (in Section
System)

Remote - Remote Desktop: Allow connections from computers running any version of
Remote desktop (less secure)
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Preparati

ions of Windows on the server

Enable Remote session

-

System Properties *

| Computer Name | Hardware | Advanced | System F‘rntac:tiun] Remate |

Femote Assistance

[} Allow Bemote Assistance connections to this computer

What happens when | enable Remote Assistance ¥

Advanced

Remote Deskiop

Click an option, and then specify who can connect, if needed.

7 Dont allow connections to this computer

i@ Allow connections from computers running any version of |
Remote Desktop {ess secure)

(71 Allow connections only from computers unning Remote
Desktop with Netwone Level Authertication {more secure)

Help me choose

Lok || Camcel |[ spoy |

Note: if you plan to connect to the measurement computer only with a Windows
computer, you can select “Allow connections only from computers running...” also.

Click on Select Users .... > Add ... > enter "ROMES" = Check Names: the name

expands to e.g. TSMW-Z3P46\ROMES.
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Preparations of Windows on the server

Setup the Wireless Access Point

.
Select Lisers

2. [ |

Select this object type;

llsers or Buil-in securty principals
From this location:

TSMW-Z3P46

Enter the object names to select (2@mples);

|. Ohiect Types.. |

|. Locations. .. |

TSMW-ZIP46\ROMES]

| Check Mames |

oK || Cancel |

| Advanced... | [_

Click OK

2.5 Setup the Wireless Access Point

Starting with Windows 7, Windows can provide a Wireless Access Point. However, this

type of network can only be configured using the comm

and line tool “netsh”.

Furthermore, it is not guaranteed, that the Wireless Access Point can be established

with any hardware. As this network has many advantag
is described in this application note:

Easier access from a client computer
embedded DHCP server for clients

More stable than an ad-hoc network
Compatible with iPads
WPAZ2 encryption instead of WEP

2.5.1 Create the Access Point

es over the ad-hoc network, it

pre-defined and well known TCP/IP address: 192.168.173.1

The access point must be created once before it can be used. This must be done in

the command shell.

Open a command shell with administrator rights:
Windows Start - All programs ... > Accessories. Right
and select Run as administrator

click on “command prompt”
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Preparations of Windows on the server

Setup the Wireless Access Point

| Accessories A
@ Bluetooth File Transfer
|:| Calculator
EX Command Reeeant '
@3 Connectta Open
B Connectta % Run as administrator
=3 Getting 5t Open file location
@ Math Input Pin to Taskbar
4 Natepan Fin to Start Meny
=2 Paint
'(.31 Remote De Restore previous versions
1=/ Run
T Send to k
% Snipping T
1, Sound Rec Cut
Sticky Mote Copy
@ Sync Cente
= Windows E Delete
@ Windows Rename
=l WordPad g ;

A command shell opens.
Enter a line like follows (must be entered in one single line):

netsh wlan set hostednetwork mode=allow ssid=TSMW-Z3P46-
ROMES key=*******xi** koyusage=persistent

Note: the key must have exactly 10 characters.
The system responds with:
The hosted network mode has been set to allow.
The SSID of the hosted network has been successfully
changed.
The user key passphrase of the hosted network has been
successfully changed.
To check the network, you may type in:
netsh wlan start hostednetwork
The system responds with:
The hosted network started

check with:

netsh wlan show hostednetwork

1SP15_OE

Rohde & Schwarz Remote Control of ROMES on Windows 7 9



Preparations of Windows on the server

Hosted network settings
Mode
SSID name
Max number of clients
Authentication
Cipher

Hosted network status
Status
BSSID
Radio type
Channel
Number of clients

The WLAN network is ready to be used.

Setup the Wireless Access Point

: Allowed

"TSMW-Z3P46-ROMES"
100

WPA2-Personal

CCMP

Started
00:23:14:24:cf:bl
802.11g

11

0

2.5.2 Create a task to start the network at system start

The WLAN network just created is stopped after reboot, so it must be started again
after any reboot. To be able to log into the computer via remote desktop, the WLAN
network must be started at system start automatically. This can be done via a Windows
task that starts at system start. Windows tasks can be created and configured in the

control panel.

Open the Control-Panel - System and Security > Schedule tasks (in section

Administrative Tools).

Click on “Create Task” (right corner, “Actions”).
Enter a name (e.g. start_wlan), don’t change Location, enter a description, click “Run
whether user is logged on or not” and enable “Run with highest privileges”.
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Preparations of Windows on the server

Setup the Wireless Access Point

(%) Create Tazk

General | Triggers | Actions | Conditions | Sett[ngs|

MName; start_wlan
Location: \
Authon TSMW-Z3P464ROMES

Description:  Starts the hosted netword at system start

Security options

When running the task, use the following user account:

TSMW-Z3PA6\ROMES Change User or Group...

() Run only when user iz logged on
@ Run whether user is logged on or net

[T] Do not store password. The task will only have access to local computer resources.

[¥] Runwith highest privileges

[] Hidden Configurefor: | Windows Vista™, Windows Server™ 2008

| ok

Select the “Triggers” tab.

Click “New...”, and select “At startup” in “Begin the task”; Click “OK”.
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Preparations of Windows on the server

Setup the Wireless Access Point

-
Mew Trigger

Begin thetask: |Atstartup -
Settings

Mo additional settings required.

Advanced settings
[T] Delay task for: |15 minutes
[| Repeattask every: |1 hour For s dinsticn ot 3 day

anmno tasks st end of

|| Stop task if it runs longer tham: 3 days

[[] Activate: 22,01 2011 | 213724 oniz
[T] Expire  |22.01.2012 21:37:24 : | Synehtonizzscioss
[¥] Enabled

[ QK J | Cancel

Select the “Action” tab.

Click “New...”, Click “Browse...” and select C:\Windows\System32\netsh.exe.
Note: the path may vary with the windows version.
Enter “wlan start hostednetwork” in “Add arguments (optional)”.
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Preparations of Windows on the server

Setup the Wireless Access Point

e

Mew Action

You must specify what action this task will perform.

Action; |Start a program

Settings

Program/script:

ChWindowsh\Systerm32\netsh, exe

Add arguments (ophional):

Start in (optional):

wilan start hostednetwaorl

QK 1 [ Cancel

The system asks for the password of the user (here: ROMES):

[ Task Scheduler - |2 [

ﬂ'ﬁ\. -

Enter user accountinformation for running this task.

User name: £ TSMW-Z3P45\ROMES

-

Pazaword; ses -|

o e
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Setup a remote connection on the client

On an iPad

After the next system start, the Wilan is active even before any user logs into the
system.

3 Setup a remote connection on the client

3.1 On aniPad

3.1.1 Get an appropriate APP

3.1.1.1 Remote desktop clients

There are several remote desktop clients available in the App Store. Select any App of
your choice. The App should support at least:

Fast Screen update

Support of right mouse key

Full screen display on the iPad

Keep sound on remote computer (only, if SQA measurements are required, see
section 4.1, “Sound Control and SQA” on page 35 for further explanation).

The following clients have been tested:

e Mocha Remote Desktop Lite, Version 2.5 (www.mochasoft.dk/iphone rdp.htm) (no
support of the right mouse key in the Lite version, however free of charge)

e iRdesktop, version 1.0.5, www.iRdeskiop.com/support

e iTap RDP, version 1.7.2.15298 (http://itap-mobile.com/itap-rdp)

The screenshots of this document have been made with iTap RDP.

3.1.2 Establish a WLAN connection

A connection to the WLAN just created on the remote PC must be established prior a
remote desktop session can be started.

Type on “Settings” on the Desktop of your iPad:
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Setup a remote connection on the client

22

Calondar Contacts

MTunes

Settings
: -"'ﬂll".ﬂntlt.' LIV T
ke Wi-Fi 7_Tulpen
m Notifications On
a4 Location Services Off

u Celiular Data
“ Brightness & Wallpaper

(& Picture Frame

i__! Mail, Contacts, Calendars

L4 safari
J54 iPod
P video
. Photos
p—

Notes

li=) Store

' iTap RDP

10:33

General

About

Usage

Sounds

Bluetooth

Spotlight Search

Auto-Lock
Passcode Lock
Restrictions

Use Side Switch to:
Lock Rotation

Mute

Date & Time

On an iPad

5 Minutes >

off >

oit >
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Setup a remote connection on the client

On an iPad

Type on “Wi-Fi” (an active Network connection may be indicated on the right of the
bar).

Settings Network

-‘Nlrpiﬂlwmvw ——T

wj wien IAlnes VPN Not Connected >
k&) Notifications on

p 4 7. Tulpen »
fa# Location Services off [ Wi J ulper

iy Cellular Data

fgd Brightness & Wallpaper
(&) Picture Frame

L.} Mail, Contacts, Calendars
£79 safari

et iPod

P video

& Photos

-Nﬂm

[ﬁ_ejﬂm

V.. iTap RDP

Wait a while until all available Networks are displayed. Type on the Network defined in

the PC (TSMW-Z3P46-ROMES, in our example).

Wi-Fi

Choose a Network...

v 7_Tulpen 8= ©
EasyBox-6F8D36 8= ©

| ( TSMW-Z3P46-ROMES J a= f}
| Other... >

Ask to Join Networks

Known networks will be joined automatfically. If no known networks are available, you
will be asked before joining a new network.

Enter the password (exactly 10 characters).
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Setup a remote connection on the client

On an iPad

-

Enter the password for "TSMW-Z3P46-ROMES”

- Enter Password

Password ecesessseces

You may examine the connection parameters by typing on the right arrow of the active
network.

Choose a Network... = =

7_Tulpen e= ©

EasyBox-6F8D36 8= © |
| v TSMW-Z3P46-ROMES & -.-
| Other... >

The IP address of the client must be 192.168.173.x and the IP address of the router
and DNS server 192.168.173.1.

IP Address
BootP : Static
IP Address 192.168.173.172
| Subnet Mask 255.255.255.0 |
| Router 192.168.173.1 |
| DNS 192.168.173.1 |
Search Domains mshome.net
Client ID

1SP15_0E Rohde & Schwarz Remote Control of ROMES on Windows 7 17



Setup a remote connection on the client

On an iPad

3.1.3 Prepare and configure a remote desktop connection

In this document, the setup of iTap RDP is described as an example. However, the
principal settings should not differ too much for the different Apps.

Start the App of your choice.

Add a new Connection (“Bookmark”).

Bookmarks rearrange
iTap RDP Testserver
i i ©
Add Manual Bookmark > .
iTap RDP Testserver
Extensions
@ Failure!
Configure Extensions >
IP: 188.40.83.250
Lock Code
User: test
Set Lock Code >

© fingar hold

iTap RDP 1.7.2.15298

toggle keyboard  toggle toolbar

Connect

16 bit  1024x768 |

A dialog with the basic settings opens. Enter at least

e the label of the connection,

e the IP address of the host

e you may enter username and password (“credentials”)

e set colors of the screen to at least 16 bit, and the resolution to at least 1024x768

1SP15_0E Rohde & Schwarz Remote Control of ROMES on Windows 7 18



Setup a remote connection on the client

On an iPad

Bookmark
Host
Label: BOMES remote >
Host: 192.168.173.1 >
Port: 3388 »

@ Host supports RDP
#: NLA (Metwork Level Authentication)

Credentials

Credentials: romes >
| Store Credentials: '
Settings

Screen: 1024x768x16 >
Advanced >

Enter the “Advanced” settings.

Select “Play on Server” in the Sound section, (only, if SQA measurements are
required, see section 4.1, “Sound Control and SQA” on page 35 for further
explanation).
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Setup a remote connection on the client

3.1.31

On an iPad
“Bookmark | Advanced
Connection
Console: | OFF |
Sound: Play on Server »
Performance >
Keyboard: Automatic >
Security Level: NLA >
Enable 3G Mode (iPad 3G only): Ol _'
3G Screen: 1024x768x16 >
3G Performance >
Automatic Reconnect: 30 Minutes >
Remote Program: >
User Interface
Border: off >

Type on “Bookmark” to return to the basic settings.
Type on “Save” to save the settings.

That's it.

Screenshots for RDP Lite

As a first starting App, RDP Lite, which is free of charge, may be chosen to test the
WiFi connection. However, this tool does not support the right mouse click, so it may
not be used in every days work.

Configuration is quite similar to the one of iTap, here are the screen shots of a
configuration, which has proven to work.
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Setup a remote connection on the client

On an iPad

Mocha RDP Lite ‘Confiqure Configure
 coa | &3
Tasks Windows PC
Connect > Pvtve 192.168.173.1 ©
PC Port
Dalault port s 3380 3389
Wake Up >
PC User (optional)
Delete and Move > Usar 1D for the Windows PC e
Add another Server > PC Password (optional) e
Typing o password horo, gives b
More Mac Address (optional)
f Only used for WOL (Wake on LAN)
Macros >
WOL port 8
Quick Guide > Wakn on LAN pont- {optionat)
About b WOL broadcast |
Help >
WOL send ping ]
Name (optional) ROMES-femote
Any plles name lor the se
More
PC keyboard type us >
Active keyboard drivar on ows PC
Screen size 1024x768 >
Mocha RDP Lite ‘Confiqure Configure
L coa | &3
Tasks e us >
Connect »
??Il‘ nfiar ’"‘l? gvis fnsier dispiay 1024 768 2
16-bit color mode
Wake Up > Us Wer § or 16 b color mode m
Delete and Move » Mouse at finger
:-r:\n hover mouso ot finger or from cursor m
Add another Server > h i
ow warning T
Display low on memory wWammgs i
More
¢ Show circle at click 1
Macros » Show a green circle al finger m_
Quick Guide > View only mode TorF |
lgnare keyboard and mouse npul
About >
Help >
Wireless keyboard OFF
Usiing & Biuntooth kaybaam
Key click
Extra keyn gives & click sound m
Toggle black toolbar TorF |
Shake the device 10 showhide the
Close session on exit oFF |

Closa RDP sassion wha:
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Setup a remote connection on the client

On a Windows PC

3.1.4 Establish a remote desktop connection

Start the Wi-Fi network and connect to the TSMW-Z3 Network as defined previously.
Start your remote desktop App, €.g. the iTap RDP.
Select the previously defined server (‘ROMES remote”) and type on “Connect”.

Search Results

No Search Resulls

Bookmarks rearrange
Y |TaFI F{DP ‘I;estsarvar ©
@ ROMES remote @
MRS ROMES remote
Add Manual Bookmark > @
b
Extensions
Configure Extensions >
Lock Code ©) fnges hold
Set Lock Code >

000

gale kevboard le tooll
iTap ROP 1.7.2 15008 toggle keyboarc toggle toolbar

—
Connect

16bit | 1024x768 | @

! # New o iTop RDP? Chack
out the manuil to learn
maoire about this app

As the credentials have been defined and stored in the profile, the user gets
automatically logged into the Windows session. You can directly start ROMES as if
directly logged into the computer.

3.2 On a Windows PC

Windows ships with all tools necessary to setup a WLAN connection and a remote
desktop session with a remote desktop server. This section describes, how to setup
and configure these tools.

3.2.1 Establish a WLAN connection

Click on the WLAN icon in the lower right corner of the desktop:
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Setup a remote connection on the client

On a Windows PC

If the remote computer is on air, the network should be contained in the list of available

networks:
Currently connected to: 6 =
S=% 7 Tulpen
oy Internet access
=% Unidentified network
o Mo network access
Dial-up and VPN h
DA Dialup Yodafone D2 ;:‘ E
Wireless Metwork Connection ~
7_Tulpen Connected 1.,”!]
TSMW-73P46-ROMES _j.ﬂﬂ
EasyBox-6fE036 ai
Mame: TSMW-Z3P46-ROMES

Skorpion Signal Strength: Excellent
Security Type: WPAZ-PSK
"""" Radio Type: 802.11g

SSI0: TSMW-Z3P46-ROMES

Click on the network “TSMW-Z3P46-ROMES”. The tool tip disappears and a pre-
selected checkbox and a button occur:
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Setup a remote connection on the client

On a Windows PC

Currently connected to: € =

“== 7 Tulpen
T Internet access

== Unidentified network
T Mo network access

Dial-up and VPN ~: | 8
04 Dialup Vodafone D2 ;;_i
Wireless Wetwork Connection A
7_Tulpen Connected _I_.mr|

TSW-Z3P45-ROMES

[¥] Connect autornatically

EasyBox-6F8036

Open Metwork and Sharing Center

Click on “Connect’. Enter the password in the next dialog

— _ __
&Y Cannect to a Network ‘

Type the network security key

Secutity key! sassesEs

| oK || Cancel

In case of success, the following tooltip is shown, if the mouse if moved over the
WLAN icon:
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Setup a remote connection on the client

On a Windows PC

TSMW-Z3P46-ROMES
Mo Intemet access

Unidentified network
MNo metwark oocess

L |‘!J':" b | ==

Note the yellow exclamation mark: this is normal, as the network has no access to the
internet.

3.2.2 Prepare and configure a remote desktop connection

The remote desktop client can be found in Accessories in the Windows Start menu.
Start > All Programs - Accessories - Remote Desktop Connection

| Accessories
) Bluetaoth File Transfer T
|| Calculatar ‘
BE Cormrmand Prompt
@5 Connect toa Metwork Projector
B Connectto a Prajector [T
= Getting Started
ﬂ Math Input Panel
j Motepad
“il Paint
5, Rernote Desktop Connection |

= Run

m

The Remote Desktop Connection starts with the following dialog:
& Remote D sktop Conrection E =] e ==

| Remote Desktop
>¢ Connection

Compiuter: E xample: computer fabiikam, com -

User name:  ROMES

The computer name field iz blank. Enter a full rermate conmputer
name,

Correct J | Help

Click on “Options” to edit the connection options to appropriate values.
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Setup a remote connection on the client

On a Windows PC

In the first tab enter remote machine name and user name. The password may be
saved, if you like, as it is more convenient, but of course more insecure.

'8, Remote Desktop Connection =] &=

| Remote Desktop
<) Connection

General | Display | Local Resources | Progams | Expeience | Advanced |

Logon zettings
E L Enter the name of the remate cornputer,

.,

Comptiker:

|zer name; ROMES

You wil be asked for credentialz when you connect;

(] Allower me bo gave credentials

Connection setings

Save the curent connection settings bo.an RDP file.or open a
| zaved connection.

Save ] l Save A, ] l Opet.. ]

‘& Options [ Caonrect Jl Help |

The “Display”-Tab may be kept unchanged.
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Setup a remote connection on the client

On a Windows PC

o

& Rernote Diesktop Connection o] = =

| Remote Desktop
¢ Connection

Dizplay configuration

Chooze the gize of pour remate deskiop. Drag the slider all the
way ta the right to uze the full screen.

Small H Large

Full Screen

|lze all my monitarz for the remote session

Colors

Chooze the caolar depth af the remate session,
b’ | Highest Quality (32 bt -

W | Dizplay the connection bar when | uze the full zcreen

‘= DOptiotz Connect ]| Help

In the tab “Local Resources”, remote audio must be configured, if SQA measurements
are required, see section 4.1, “Sound Control and SQA” on page 35 for further
explanation.
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Setup a remote connection on the client

On a Windows PC

e

. Rernote Desktop Confiection

| Remote Desktop
¢ Connection

Remate audia

. GeMtings.

K.epboard

R

| General [ Display| Local Resources | Programs | Experisnce | Advanced|
Configure remote audio settings,

Apply Windows key combinations:

Oy whien wzing the full screen -

Example: AL T+TAR

Local devices and resources

iﬂ_l'@] pour remate sessioh.

J Choose the devices and résources that vol want ba GEe in

(] Printers [¥] Clipbaard
. Mare...
‘= Optiohs | Conrect H Help

For SQA jobs, remote audio playback must be set to “play on remote computer”. If
ROMES events are used, remote audio playback should be set to “Play on this

computer”.
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Setup a remote connection on the client

' Remote Desktop
¢ Connection

Remote audio plapback:
G (0 Play o this compuber
S 0 Daonot play

o rermohe computber

Remote audio recording
" Record from this compiitar

{ i@ Do not record

‘Remute Desktop Connection = ==

Ok ]| Cancel

On a Windows PC

Local resources may be configured to enable data transfer with the remote PC. A data
drive, e.g. drive “D” may be made accessible via network drive on the remote machine:

' Remote Desktop
<) Connection

Local devices and rezources

Choose the devices and resources on thiz-computer that vou want to
Lz ih pour remate session,

[¥] Smiart cards

[ Ptz

&) Remote Diesktop Connection |

=1 Drives P

| R Dirive
[T i 18

[T DT

[TTiF:) DT

[ Drives that | plug in later
[# || Other supported Plug and Play [PrP] devices

W'hich Plug and Play devices can | use inmy remote sesson?

Ok ]| Cancel

Programs may be kept as set by default.
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Setup a remote connection on the client

& Remote Desktop Connection

| Remote Desktop
> Connection

E =l )

Start a program
T [CliStart the following program on connection:
Fr noram path and file mame
art i the ol |de
(- Options Connect J l Help

On a Windows PC

In the tab “Experience”, the amount of visual effects transferred via LAN can be
configured according to your personal needs. Default is shown in the next figure:
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Setup a remote connection on the client

On a Windows PC

| Remote Desktop
> Connection

| General I.D_isplag,[l Local Hesuutces~| F'r-jgrams~| Experience |.-'1'-.|:|vanceu:|

Perfarmance

Choose your connection speed to optinize perfarmance,

= [;an-sneed breadband (256 Ebps -2 Mbps| F _r]

Allaw the following:

[ Desktop backaground

[7] Font smoathing

[ Desktop composition

[] Shiow window contents while dragging
[] Meniu arid window animation

Yigyal styles

[¥] Persistent bitmap caching

[¥] Reconnect if the cornection is diopped

(= Options Cannect ]l Help |

The settings in the “Advanced” tab can be left as per default.
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Setup a remote connection on the client

On a Windows PC

o

8., Rernots Desktop Connection ===

| Remote Desktop
¢ Connection

| General [ Display | Local Resources | Frograms | Experisnce | Advanced |

Server authentication

=] Server authentication verifies that you are connecting to the
intended remote computer. The strength of the verification
required to connect iz determined by vaur system security

policy.

[f zerver authentication fails:

léEn:nnnen::t and dan'twarn me iw

"What are my server authentication options?

Connect fram anmahers

B Configure setiings to-connect through Remote Desktop
G'@ Gateway whern| am warking rermotely.

| Sethings...

(& Options Conrect ]| Help

Do not forget to save these settings in the end. This can be done in the “General” tab
again. Click on “Save As ...” button and save the Settings to a file of your choice.

Note: the extension of this file should be “RDP”
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Setup a remote connection on the client

On a Windows PC

B, Remate Desktop Connection =<

' Remote Desktop
¢ Connection

General | Display | Local Resources | Programs | Experience | Advanced|

Logon =ettings
Enter the name af the remate cornputer.

f |
'd:"'aq_

Compuiter;

|zer name; ROMES

Youwill be-azked for credentials when you connect;

[@] Sllows me to zave credentialz

Connection settings

S ave the current connection zettingz to.an RDF e or open a
zaved connechion.

Save n Savebs H Opet... ]

(& Options [ Caonnect ]| Help |

3.2.3 Establish a remote desktop connection

Make sure that the WLAN connection has been established.

Double click on the file saved as described in the previous section. A dialog opens.
Click on “connect”. A warning occurs. Click on “Don’t’s ask me again...” and then on
“Connect”.

After a while the Windows Security dialog opens. Enter the password and click
“‘Remember my credentials”, if you like.

The session should open as:
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Setup a remote connection on the client

On a Windows PC

— = = —

Windows Secuity & =

Enter your credentials
These credentials will be used to connect to tsmw-23pd6.

ROMES

| Use another account

|- : Imsert a smart card

==
r'r'l ember my credentials

(% Rernote Desktop Connection ==

O Do you truzt this remote connection?

Thiz remote connection could harm-your local or remote computer. Make sure that pou trust the
remote computer before you connect.

% Type: Remaote Dezklop Connection
b Femote computer; tsmw-23p45
Dn't azk: me again for connectionz to this computer
= Details [ Eonnect: ] Cancel
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Tips for Remote Controlled Sessions

Sound Control and SQA

4 Tips for Remote Controlled Sessions

4.1 Sound Control and SQA

The RDP protocol allows to transfer sound from the server (“host”) to the client
machine. On Windows PCs, this is the default setting. While this is desired for multi
media machines, where the host serves music which are listened to at the client PC,
measurements with ROMES require a different mode.

If SQA measurements are performed on the remote machine, the sound must remain
on the host, see sections 3.1.3, “Prepare and configure a remote desktop connection”
on page 18 and 3.2.2, “Prepare and configure a remote desktop connection”, on
page 25.

If no SQA measurements are performed, but the sound should be heard on the client,
then the RDP session must be configured to “play on device”.

Correct settings can easily be checked by playing any sound file on the remotely
controlled PC. If the sound can be heard on the remote computer, SQA measurements
are possible, if it can be heard on the client PC, then SQA measurements are
impossible, but sound events can be routed from server to the client PC.

4.2 Power Down and Restart

Power down resp. restart of Windows is disabled in the Windows Start Menu for
remotely controlled sessions by default. This is convenient for Windows Servers which
rarely are powered down in normal circumstances. However, a measurement system
needs to be powered down daily and needs to be rebooted from time to time, e.g. after
new hardware has been installed. To be able to reboot or shut down a remote session,
a command “shutdown” is available on Windows, which may be run directly.

Click on Start > Run ... and enter

shutdown -r
to reboot the computer.
Click on Start > Run ... and enter
shutdown -s
to shut down the computer.
It is convenient to establish two batch jobs containing these commands and store them

on the desktop. Take care to name these not shutdown.cmd, as in this case Windows
recursively calls the job (shutdown.cmd) and not built in command reboot.exe.
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Literature

Power Down and Restart

5 Literature

[11 1SP51_1E, Remote Control of ROMES with a Pocket PC

6 Additional Information

This Application Note is subject to updates and extensions. Please visit our website
in order to download new versions. Please send any comments or suggestions about
this application Note to TM-Applications@rohde-schwarz.com

7 Ordering Information

Drive Test System

ROMES Drive Test Software 1117.6885.04
ROMES-T1W 1117.6885.02
TSMW Universal Network Analyzer 1503.3001.03
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About Rohde & Schwarz

Rohde & Schwarz is an independent group
of companies specializing in electronics. It is
a leading supplier of solutions in the fields of
test and measurement, broadcasting,
radiomonitoring and radiolocation, as well as
secure communications. Established more
than 75 years ago, Rohde & Schwarz has a
global presence and a dedicated service
network in over 70 countries. Company
headquarters are in Munich, Germany.

Environmental commitment
e Energy-efficient products
e Continuous improvement in
environmental sustainability
e ISO 14001-certified environmental
management system

Certified Quality System

IS0 9001

Regional contact

Europe, Africa, Middle East

+49 89 4129 137 74
customersupport@rohde-schwarz.com

North America
1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Latin America
+1-410-910-7988
customersupport.la@rohde-schwarz.com

Asia/Pacific
+65 65 13 04 88
customersupport.asia@rohde-schwarz.com

This application note and the supplied
programs may only be used subject to the
conditions of use set forth in the download
area of the Rohde & Schwarz website.

R&S® is a registered trademark of Rohde & Schwarz
GmbH & Co. KG; Trade names are trademarks of the
owners.
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